
User’s Guide  [GDI Printer Controller]



Introduction

Thank you for purchasing this machine.

This manual provides the information required to use this machine as a GDI 
printer.

Be sure to read this manual before performing any operations.

For precautions concerning the use and safety of the machine, refer to the 
User’s Guide provided with the machine.

Store the CD-ROM and User’s Guides provided with the machine in a safe 
place.

bizhub 163/211 is not sold in the USA market.

Trademarks and copyright
- KONICA MINOLTA, the KONICA MINOLTA logo, and The essentials of 

imaging are registered trademarks of KONICA MINOLTA HOLDINGS, 
INC.

- PageScope and bizhub are registered trademarks or trademarks of 
KONICA MINOLTA BUSINESS TECHNOLOGIES INC.

- Netscape is a registered trademark of Netscape Communications Corpo-
ration in the United States and other countries.

- Novell and Novell NetWare are registered trademarks of Novell, Inc. in the 
United States and other countries.

- Microsoft, Windows, and Windows NT are either registered trademarks 
or trademarks of Microsoft Corporation in the United States and/or other 
countries.

- Adobe, the Adobe logo, Acrobat and PostScript are either registered 
trademarks or trademarks of Adobe Systems Incorporated in the United 
States and/or other countries.

- Ethernet is a registered trademark of Xerox Corporation.
- PCL is a registered trademark of Hewlett-Packard Company Limited.
- All other product and brand names are trademarks or registered trade-

marks of their respective companies or organizations.
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Copyright

© 2007 Konica Minolta Business Technologies, Inc. All Rights Reserved.

Note
- This User’s Guide may not be reproduced in part or in full without permis-

sion.
- Konica Minolta Business Technologies, Inc. will not be held liable for any 

incidents caused by using this printing system or User’s Guide.
- Information included in this User’s Guide is subject to change without no-

tice.
- Konica Minolta Business Technologies, Inc. maintains the copyright of 

the printer drivers.
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Software End User License Agreement

PLEASE READ CAREFULLY THE LICENSE AGREEMENT BELOW BEFORE 
OPENING THE PACKAGE OF THIS SOFTWARE (“SOFTWARE”), DOWN-
LOADING, INSTALLING OR USING THE SOFTWARE. OPENING THE PACK-
AGE, OR DOWNLOADING, INSTALLING OR USING THE SOFTWARE 
SHALL BE DEEMED YOUR LAWFUL ACCEPTANCE OF THE TERMS AND 
CONDITIONS BELOW. IF YOU DO NOT AGREE TO THEM, DO NOT DOWN-
LOAD, INSTALL, USE THE SOFTWARE, NOR OPEN THE PACKAGE.

1. COPYRIGHT AND INTELLECTUAL PROPERTY RIGHTS

This is a license agreement and not an agreement for sale. Konica Minolta 
Business Technologies, Inc.(“Konica Minolta”) owns, or has been licensed 
from other owners (“Konica Minolta Licensor”), copyrights and other intellec-
tual property rights of the Software, and any and all rights and title to the 
Software and any copy made from it are retained by Konica Minolta or Koni-
ca Minolta Licensor. In no event, this Agreement shall be deemed to assign 
any copyright and/or any intellectual property rights of the Software from 
Konica Minolta or Konica Minolta Licensor to you. The Software is protected 
by copyright laws and international treaty provisions.

2. LICENSE

Konica Minolta hereby grant to you a non-exclusive and limited license, and 
you may:

(i) install and use the Software only on your computer(s) connected with 
Konica Minolta product for which this Software is designed;

(ii) allow users of the computers described above to use the Software, pro-
vided that you assure that all such users comply with the terms of this Agree-
ment;

(iii) use the Software only for your own customary business or personal pur-
pose;

(iv) make one copy of the Software only for backup purpose in the support 
of the normal and intended use of the Software.

(v) transfer the Software to other party by transferring a copy of this Agree-
ment and all documentation along with the Software, provided that (a) you 
must, at the same time, either transfer to such other party or destroy all your 
other copies of the Software, (b) such transfer of possession terminates your 
license from Konica Minolta, and (c) you must assure that such other party 
has agreed to accept the terms and conditions of this Agreement. If such 
other party does not accept such terms and conditions then you shall not 
transfer any copy of the Software.

3. RESTRICTIONS

(1) You shall not without the written consent of Konica Minolta:
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(i) use, copy, modify, merge or transfer copies of the Software except as pro-
vided herein;

(ii) reverse engineer, reverse assemble, reverse compile or any other way an-
alyze the Software; or

(iii) sublicense, rent, lease or distribute the Software or any copy thereof.

(iv) remove, use, or alter any trademark, logo, copyright or other proprietary 
notices, legends, symbols or labels in the Software.

(2) You agree that you will not export the Software in any form in violation of 
any applicable laws and regulations regarding export control of any country.

4. DISCLAIMER OF WARRANTIES

(1) If the Software is furnished on CD-ROM(s) or other tangible object that is 
used for storage of digital data (hereinafter collectively “Storage Medium”), 
Konica Minolta warrants the Storage Medium to be free from the defects in 
material and workmanship under normal use, for a period of ninety (90) days 
from the date of delivery to you. WITH THE EXCEPTION OF THE FOREGO-
ING EXPRESS WARRANTIES APPLICABLE TO STORAGE MEDIUM ONLY, 
THE SOFTWARE IS PROVIDED TO YOU “AS IS” WITHOUT ANY WARRAN-
TIES WHATSOEVER. KONICA MINOLTA, ITS AFFILIATE COMPANIES AND 
KONICA MINOLTA LICENSOR DISCLAIM ALL WARRANTIES WITH RE-
GARD TO THE SOFTWARE, EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR A PARTICULAR PURPOSE AND NON-INFRINGEMENT OF THIRD 
PARTY RIGHTS. 

(2) IN NO EVENT WILL KONICA MINOLTA, ITS AFFILIATE COMPANIES NOR 
KONICA MINOLTA LICENSOR BE LIABLE FOR ANY LOST PROFITS, LOST 
DATA, OR ANY OTHER INDIRECT, SPECIAL, PUNITIVE, INCIDENTAL OR 
CONSEQUENTIAL DAMAGES THAT RESULT FROM USE OR INABILITY TO 
USE THE SOFTWARE INCLUDING WITHOUT LIMITATION, DAMAGES FOR 
LOSS OF GOODWILL, COMPUTER FAILURE OR MALFUNCTION OR ANY 
AND ALL OTHER COMMERCIAL OR OTHER DAMAGES OR LOSSES, EVEN 
IF KONICA MINOLTA, ITS AFFILIATE COMPANIES OR KONICA MINOLTA 
LICENSOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAG-
ES OR FOR ANY CLAIM BY YOU BASED ON A THIRD PARTY CLAIM.

(3) The disclaimer of warranty hereunder does not affect your statutory rights. 
In case of the disclaimer is not allowed by applicable law, the disclaimer shall 
only apply to you to the maximum extent permitted by the law.

5. TERMINATION

You may terminate this license at any time by destroying the Software and 
all your copies of it. This Agreement shall also terminate if you fail to comply 
with any terms hereof. Upon such termination, you must immediately destroy 
all copies of the Software in your possession.
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6. GOVERNING LAW

This Agreement shall be governed by the laws of Japan.

7. SEVERABILITY

In the event that any part or parts of this agreement shall be held illegal or 
null and void by any court or administrative body of competent jurisdiction, 
such determination shall not effect the remaining parts of this agreement and 
they shall remain in full force and effect as if such part or parts determined 
illegal or void had not been included.

8. NOTICE TO US GOVERNMENT END USERS

The Software is a “commercial item,” as that term is defined at 48 C.F.R. 
2.101 (October 1995), consisting of “commercial computer software” and 
“commercial computer software documentation,” as such terms are used in 
48 C.F.R. 12.212 (September 1995). Consistent with 48 C.F.R. 12.212 and 
48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995), all U.S. Government 
End Users shall acquire the Software with only those rights set forth herein.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS AGREEMENT, UN-
DERSTAND IT, AND AGREE TO BE BOUND BY ITS TERMS AND CONDI-
TIONS. NEITHER PARTY SHALL BE BOUND BY ANY OTHER STATEMENTS 
OR REPRESENTATIONS THAT ARE INCONSISTENT WITH THE TERMS 
AND CONDITIONS OF THIS AGREEMENT. NO AMENDMENT TO THIS 
AGREEMENT IS EFFECTIVE UNLESS WRITTEN AND SIGNED BY PROPER-
LY AUTHORIZED REPRESENTATIVES OF EACH PARTY. BY OPENING THE 
PACKAGE, DOWNLOADING, INSTALLING OR USING THE SOFTWARE 
YOU AGREE TO ACCEPT THE TERMS OF THIS AGREEMENT.
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Getting ready 1
1 Getting ready

1.1 Operating environment

System requirements

The following environment is required so that the printer driver can be used.
- Intel Pentium 200 MHz
- Windows Server 2003, Windows XP (Service Pack 2 or later), Windows 

2000 (Service Pack 4 or later), Windows Me, or Windows 98 SE
- 128 MB RAM (Windows XP/Server 2003), 64 MB RAM (Windows 2000/

Me/98 SE)
- USB port compliant with USB Revision 2.0
- CD-ROM/DVD drive

2
Note 

The printer driver is not compatible with Windows 95/98/NT 4.0.

Recommended operating environment

Pentium 4/1.6 GHz

256 MB RAM
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Installing the printer driver 2
2 Installing the printer driver

Descriptions on connecting the machine to a computer and installing the 
printer driver are provided below.

2.1 Making connections and installing the driver

Connecting to a computer

This machine can be connected to a computer using any of the following 
connection methods.

Connecting to a USB port

In the following procedure, the machine is connected directly to the compu-
ter by using a USB cable.

When the machine is connected to the USB port, installation of the TWAIN 
and printer drivers begins. For the procedure on installing the TWAIN and 
printer drivers when this machine is connected by USB, refer to “Installing 
the printer driver by using Plug and Play” on page 2-6.
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2 Installing the printer driver
Connecting to the network

In the following procedure, the machine is connected directly to the compu-
ter by using a network cable.

In order to connect the machine to a network, the optional network interface 
card NC-503 or image controller IC-206 must be installed. For details on the 
network interface card NC-503, refer to the User’s Guide for the network in-
terface card. For details on the image controller IC-206, refer to the User’s 
Guide for the image controller.

When the machine is connected to a network, use the Add Printer Wizard to 
install the printer driver. For the procedure on installing the printer driver 
when this machine is connected to a network, refer to “Installing the printer 
driver by using the Add Printer Wizard” on page 2-13.

Procedures for making connections and installing the driver

The printer driver can be installed by using Plug and Play or by using the Add 
Printer Wizard.

The installation procedure differs depending on the method used to make 
the connection. Use the installation method that corresponds with the con-
nection method.

2
Reminder 

If the machine is to be connected to a USB port, install the driver by using 
Plug and Play. If the machine is to be connected to a network, install the 
driver by using the Add Printer Wizard.
2-2 GDI Printer Controller



Installing the printer driver 2
2
Note 

When installing using Plug and Play, the TWAIN driver for scanning is also 
installed with the printer driver. For details on the TWAIN driver, refer to 
the User’s Guide for the TWAIN driver. 

Connection 

method

Supported operating 

systems

Printer driver installation method

USB port con-
nection

Windows XP/Windows 
Server 2003/Windows 
2000/Windows Me/Win-
dows 98 SE

Install using Plug and Play.
For details, refer to “Installing the printer driver by 
using Plug and Play” on page 2-6.

Network con-
nection

Windows XP/Windows 
Server 2003/Windows 
2000/Windows Me/Win-
dows 98 SE

Install using the Add Printer Wizard.
For details, refer to “Installing the printer driver by 
using Plug and Play” on page 2-6.
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2 Installing the printer driver
2.2 General operation for driver installation

The driver is installed according to the following general operation.

Installation using Plug and Play

When installing the driver by using Plug and Play, the installation procedure 
differs depending on the operating system.

With Windows 98 SE With Windows Me With Windows XP, 
Windows Server 2003 and 
Windows 2000

Install the USB-compatible 
device driver.

Install the USB printing 
support driver.

Install the TWAIN driver.

Install the USB printing 
support driver.

Install the printer driver.
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Installing the printer driver 2
Installation using the Add Printer Wizard

When installing the printer driver by using the Add Printer Wizard, the instal-
lation procedure is the same for all operating systems.

With Windows 98 SE With Windows Me With Windows XP, 
Windows Server 2003 and 
Windows 2000

Install the printer driver.
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2 Installing the printer driver
2.3 Installing the printer driver by using Plug and Play

Connecting to the computer’s USB port

When this machine is connected to a computer with a USB cable, Plug and 
Play detects the device, and then installation of the necessary drivers begins.

1 Start Windows, and then insert the CD-ROM/DVD into the computer’s 
CD-ROM drive.

2 Turn on this machine.

3 After this machine starts up and is ready for copying, connect it to the 
computer with the USB cable.

This machine is detected, and the Found New Hardware Wizard (Add New 
Hardware Wizard on Windows Me/98 SE) appears.

The remainder of the procedure differs depending on the operating system. 
Follow the appropriate procedure according to the operating system being 
used.
- For Windows XP and Windows Server 2003: “Installing using Plug and 

Play on Windows XP/Server 2003” on page 2-7
- For Windows 2000: “Installing using Plug and Play on Windows 2000” on 

page 2-8
- For Windows Me: “Installing using Plug and Play on Windows Me” on 

page 2-9
- For Windows 98 SE: “Installing using Plug and Play on Windows 98 SE” 

on page 2-10

2
Note 

With Windows XP, Server 2003 and 2000, log on as a user with Adminis-
trator privileges to install the printer driver.
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Installing the printer driver 2
Installing using Plug and Play on Windows XP/Server 2003

2
Note 

If the driver is installed using Plug and Play, first the TWAIN driver for 
scanning is installed, and then installation of the printer driver begins. The 
procedure described in this manual is for the installation of the TWAIN 
driver, then the printer driver. For details on the TWAIN driver, refer to the 
User’s Guide for the TWAIN driver.

2
Note 

When using Windows XP (Service Pack 2), a dialog box appears, re-
questing confirmation to connect to Windows Update. At this time, select 
“NO”, and then click the [Next] button.

Follow the instructions that appear in the Found New Hardware Wizard to 
complete the installation.

1 Select “Install from a list or specific location [Advanced]”, and then 
click the [Next] button.

2 Select “Include this location in the search:” and then specify the follow-
ing folder on the CD-ROM as the location where the driver is saved.

– Folder to be specified: \Driver\<model_name>\English\WIN2K_XP
– The folder can be selected after clicking the [Browse] button.
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2 Installing the printer driver
3 Click the [Next] button.

– When the Windows logo testing warning message appears, click 
the [Continue Anyway] button.

The Completing Found New Hardware Wizard dialog box appears.

4 Click the [Finish] button.

This completes the installation of the TWAIN driver.
The Found New Hardware Wizard appears again, and the installation 
of the printer driver begins.

5 Repeat steps 1 through 4 to install the printer driver.

Installing using Plug and Play on Windows 2000

2
Note 

If the driver is installed using Plug and Play, first the TWAIN driver for 
scanning is installed, and then installation of the printer driver begins. The 
procedure described in this manual is for the installation of the TWAIN 
driver, then the printer driver. For details on the TWAIN driver, refer to the 
User’s Guide for the TWAIN driver.

Follow the instructions that appear in the Found New Hardware Wizard to 
complete the installation.

1 Check the contents of the Found New Hardware Wizard, and then click 
the [Next] button.

2 Select “Search for a suitable driver for my device [recommended]” and 
then click the [Next] button.

3 Select “Specify a location” and then click the [Next] button.

4 Specify the following folder on the CD-ROM as the location where the 
driver is saved.

– Folder to be specified: \Driver\<model_name>\English\WIN2K_XP
– The folder can be selected after clicking the [Browse] button.

5 Click the [Next] button.

– When the Microsoft digital signature warning message appears, 
click the [Yes] button.

The Completing Found New Hardware Wizard dialog box appears.
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Installing the printer driver 2
6 Click the [Finish] button.

This completes the installation of the TWAIN driver.
The Found New Hardware Wizard appears again, and the installation 
of the printer driver begins.

7 Repeat steps 1 through 6 to install the printer driver.

Installing using Plug and Play on Windows Me

2
Note 

If the driver is installed using Plug and Play, first the TWAIN driver for 
scanning is installed, next the USB printing support driver is installed, and 
then installation of the printer driver begins. The procedure described in 
this manual is for the installation of the TWAIN driver, the USB printing 
support driver, then the printer driver. For details on the TWAIN driver, re-
fer to the User’s Guide for the TWAIN driver.

Follow the instructions that appear in the Add New Hardware Wizard to com-
plete the installation.

1 Select “Specify the location of the driver (Advanced)” and then click the 
[Next] button.

2 Select “Specify a location” and then specify the following folder on the 
CD-ROM as the location where the driver is saved.

– Folder to be specified: \Driver\<model_name>\English\Win98_ME
– The folder can be selected after clicking the [Browse] button.

3 Click the [Next] button.

4 Check the location of the driver, and then click the [Next] button.

A dialog box appears, indicating that the installation is finished.

5 Click the [Finish] button.

This completes the installation of the TWAIN driver.
The Add New Hardware Wizard appears again, and the installation of 
the USB printing support driver begins.
GDI Printer Controller 2-9



2 Installing the printer driver
6 Repeat steps 1 through 5 to install the USB printing support driver.

This completes the installation of the USB printing support driver.
The Add New Hardware Wizard appears again, and the installation of 
the printer driver begins.

7 Repeat steps 1 through 4 to install the printer driver.

A dialog box appears, allowing you to specify the printer name.

8 Click the [Finish] button.

– To change the printer name, type in the new name.
– To set this machine as the default, select “Yes”.
A dialog box appears, indicating that the installation is finished.

9 Click the [Finish] button.

This completes the installation of the printer driver.

Installing using Plug and Play on Windows 98 SE

2
Note 

If the driver is installed using Plug and Play, first the USB-compatible de-
vice driver is installed, next the USB printing support driver is installed, 
then the TWAIN driver for scanning is installed, and then installation of 
the printer driver begins. The procedure described in this manual is for 
the installation of the USB-compatible device driver, the USB printing 
support driver, the TWAIN driver, then the printer driver. For details on the 
TWAIN driver, refer to the User’s Guide for the TWAIN driver.

Follow the instructions that appear in the Add New Hardware Wizard to com-
plete the installation.

1 Check the contents of the Add New Hardware Wizard, and then click 
the [Next] button.

2 Select “Search for the best driver for your device [recommended]” and 
then click the [Next] button.

3 Select “Specify a location” and then specify the following folder on the 
CD-ROM as the location where the driver is saved.

– Folder to be specified: \Driver\<model_name>\English\Win98_ME
– The folder can be selected after clicking the [Browse] button.

4 Click the [Next] button.
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Installing the printer driver 2
5 Select “The updated driver (Recommended)” and then click the [Next] 
button.

6 Check the location of the driver, and then click the [Next] button.

A dialog box appears, indicating that the installation is finished.

7 Click the [Finish] button.

This completes the installation of the USB-compatible device driver.
The Add New Hardware Wizard appears again, and the installation of 
the USB printing support driver begins.

8 Click the [Next] button.

9 Select “Search for the best driver for your device. [recommended]” and 
then click the [Next] button.

10 Select “Specify a location” and then specify the following folder on the 
CD-ROM as the location where the driver is saved.

– Folder to be specified: \Driver\<model_name>\English\Win98_ME
– The folder can be selected after clicking the [Browse] button.

11 Click the [Next] button.

12 Check the location of the driver, and then click the [Next] button.

A dialog box appears, indicating that the installation is finished.

13 Click the [Finish] button.

This completes the installation of the USB-compatible device driver.
The Add New Hardware Wizard appears again, and the installation of 
the TWAIN driver for scanning begins.

14 Repeat steps 8 through 13 to install the TWAIN driver.

This completes the installation of the TWAIN driver.
The Add New Hardware Wizard appears again, and the installation of 
the printer driver begins.

15 Repeat steps 8 through 12 to install the printer driver.

A dialog box appears, allowing you to specify the printer name.

16 Click the [Finish] button.

– To change the printer name, type in the new name.
– To set this machine as the default, select “Yes”.
A dialog box appears, indicating that the installation is finished.
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2 Installing the printer driver
17 Click the [Finish] button.

This completes the installation of the printer driver.

Reinstalling the printer driver by using Plug and Play

1 Uninstall the printer driver while the machine is not connected to the 
computer or while they are connected but the machine is turned off, 
and then restart the computer.

– For details, refer to “Uninstalling the printer driver” on page 2-22.

2 Use the USB cable to connect the machine to the computer.

3 Follow the on-screen instructions to reinstall the printer driver.

– When the dialog box for specifying the folder appears, insert the 
CD-ROM, and then continue the installation.

– If Windows 98 SE is being used, click the [OK] button when the In-
sert Disk dialog box appears, and then continue the installation.
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Installing the printer driver 2
2.4 Installing the printer driver by using the Add Printer 
Wizard

Connecting to a computer through a network

If this machine is connected to a computer through a network, the printer 
driver can be installed either before or after the connection is established.

2
Note 

The optional network interface card NC-503 or image controller IC-206 
must be installed in order to establish a network connection.

% Use the network cable to connect this machine to the computer.

The remainder of the printer driver installation procedure differs depending 
on the operating system. Follow the appropriate procedure according to the 
operating system being used.
- For Windows XP and Windows Server 2003: “Installing using the Add 

Printer Wizard on Windows XP/Server 2003” on page 2-14
- For Windows 2000: “Installing using the Add Printer Wizard on Windows 

2000” on page 2-17
- For Windows Me/98 SE: “Installing using the Add Printer Wizard on Win-

dows Me/98 SE” on page 2-19

2
Note 

With Windows XP, Server 2003 and 2000, log on as a user with Adminis-
trator privileges to install the printer driver.
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2 Installing the printer driver
Installing using the Add Printer Wizard on Windows XP/Server 2003

2
Note 

When using a USB cable to connect this machine to the computer, turn 
off this machine, and then install the printer driver. When the machine is 
turned on, Plug and Play causes the Add New Hardware Wizard to ap-
pear.

1 After Windows has started, insert the printer driver CD-ROM into the 
CD-ROM drive of the computer.

2 Click the Windows [Start] button, and then click “Printers and Faxes”.

– The Printers and Faxes window appears.
– If “Printers and Faxes” does not appear in the Start menu, click 

“Control Panel” in the Start menu, click “Printers and Other Hard-
ware”, and then click “Printers and Faxes”.

3 Click “Add a Printer” under “Printer Tasks”.
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Installing the printer driver 2
– If “Printer Tasks” does not appear, double-click the “Add Printer” 
icon.

The Add Printer Wizard starts up.

4 Click the [Next] button.

5 Select “Local printer attached to this computer”, and then click the 
[Next] button.

– The “Automatically detect and install my Plug and Play printer” 
check box should be cleared.

– In order to print on a network, the connection port must be set up 
as a network port. Since the port settings can be specified after in-
stallation, this procedure describes how to install the printer driver 
for a local connection. For details on specifying the port settings, 
refer to the User’s Guide for the network interface card.

6 Select “LPT1: (Recommended Printer Port)” beside “Use the following 
port”, and then click the [Next] button.

7 Click the [Have Disk] button.
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2 Installing the printer driver
8 Click the [Browse] button, select “Driver\<model_name>\Eng-
lish\WIN2K_XP” on the CD-ROM, and then click the [Open] button.

9 Click the [Open] button again.

10 Check the path in the “Copy manufacturer’s files from” box, and then 
click the [OK] button.

11 Select the printer to be installed, and then click the [Next] button.

12 Continue selecting the appropriate settings according to your environ-
ment and clicking the [Next] button until the [Finish] button appears.

– For a network connection, perform a test print after specifying the 
network settings.

13 Click the [Finish] button.

– If the Windows logo testing warning message appears, click the 
[Continue Anyway] button.

14 After installation is complete, check that the icon for the installed print-
er appears in the Printers and Faxes window, and then remove the CD-
ROM from the CD-ROM drive.

This completes the installation of the printer driver.
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Installing using the Add Printer Wizard on Windows 2000

2
Note 

When using a USB cable to connect this machine to the computer, turn 
off this machine, and then install the printer driver. When the machine is 
turned on, Plug and Play causes the Add New Hardware Wizard to ap-
pear.

1 After Windows has started, insert the printer driver CD-ROM into the 
CD-ROM drive of the computer.

2 Click the Windows [Start] button, point to “Settings”, and then click 
“Printers”.

The Printers window appears.

3 Double-click the “Add Printer” icon.

The Add Printer Wizard starts up.

4 Click the [Next] button.

5 Select “Local printer”, and then click the [Next] button.

– The “Automatically detect and install my Plug and Play printer” 
check box should be cleared.

– In order to print on a network, the connection port must be set up 
as a network port. Since the port settings can be specified after in-
stallation, this procedure describes how to install the printer driver 
for a local connection. For details on specifying the port settings, 
refer to the User’s Guide for the network interface card.
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6 Select “LPT1:” beside “Use the following port”, and then click the 
[Next] button.

7 Click the [Have Disk] button.

8 Click the [Browse] button, select “Driver\<model_name>\Eng-
lish\WIN2K_XP” on the CD-ROM, and then click the [Open] button.

9 Click the [Open] button again.

10 Check the path in the “Copy manufacturer’s files from” box, and then 
click the [OK] button.

11 Select the printer to be installed, and then click the [Next] button.

12 Continue selecting the appropriate settings according to your environ-
ment and clicking the [Next] button until the [Finish] button appears.

– For a network connection, perform a test print after specifying the 
network settings.

13 Click the [Finish] button.

– If the digital signature warning message appears, click the [Yes] 
button.

14 After installation is complete, check that the icon for the installed print-
er appears in the Printers window, and then remove the CD-ROM from 
the CD-ROM drive.

This completes the installation of the printer driver.
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Installing using the Add Printer Wizard on Windows Me/98 SE

2
Note 

When using a USB cable to connect this machine to the computer, turn 
off this machine, and then install the printer driver. When the machine is 
turned on, Plug and Play causes the Add New Hardware Wizard to ap-
pear.

1 After Windows has started, insert the printer driver CD-ROM into the 
CD-ROM drive of the computer.

2 Click the Windows [Start] button, point to “Settings”, and then click 
“Printers”.

The Printers window appears.

3 Double-click the “Add Printer” icon.

The Add Printer Wizard starts up.

4 Click the [Next] button.

5 Select “Local printer”, and then click the [Next] button.

– In order to print on a network, the connection port must be set up 
as a network port. Since the port settings can be specified after in-
stallation, this procedure describes how to install the printer driver 
for a local connection. For details on specifying the port settings, 
refer to the User’s Guide for the network interface card.

6 Click the [Have Disk] button.
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7 Click the [Browse] button, select “Driver\<model_name>\Eng-
lish\Win98_ME” on the CD-ROM, and then click the [OK] button.

8 Click the [OK] button again.

9 Check the path in the “Copy manufacturer’s files from” box, and then 
click the [OK] button.

10 Select the printer to be installed, and then click the [Next] button.

11 Select “LPT1:” as the port to be used, and then click the [Next] button.

– In order to print on a network, the connection port must be set up 
as a network port. Since the port settings can be specified after in-
stallation, this procedure describes how to install the printer driver 
for a local connection. For details on specifying the port settings, 
refer to the User’s Guide for the network interface card.

12 Click the [Finish] button.

13 After installation is complete, check that the icon for the installed print-
er appears in the Printers window, and then remove the CD-ROM from 
the CD-ROM drive.

This completes the installation of the printer driver.
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Reinstalling the printer driver by using the Add Printer Wizard

1 Uninstall the printer driver while the machine is not connected to the 
computer or while they are connected but the machine is turned off, 
and then restart the computer.

– For details, refer to “Uninstalling the printer driver” on page 2-22.

2 Use the Add Printer Wizard to reinstall the printer driver.
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2.5 Uninstalling the printer driver

2
Note 

With Windows XP, Server 2003 and 2000, log on as a user with Adminis-
trator privileges to delete the printer driver.

For details on deleting the TWAIN driver, refer to the User’s Guide for the 
TWAIN driver.

Delete the printer

1 Open the Printers and Faxes window. (With Windows 2000/Me/98 SE, 
open the Printers window.)

– For Windows XP/Server 2003, click the [Start] button, and then 
click “Printers and Faxes”.

– For Windows 2000/Me/98 SE, click the [Start] button, point to “Set-
tings”, and then click “Printers”.

– If “Printers and Faxes” does not appear in the Start menu in Win-
dows XP/Server 2003, click “Control Panel” in the Start menu, click 
“Printers and Other Hardware”, and then click “Printers and Faxes”.

2 Select the name of this printer, and then press the [Delete] key in the 
keyboard.

– If a message appears, indicating that the related files will be delet-
ed, they will be deleted.

– If Windows XP, Server 2003 or 2000 is being used, continue with 
step 3.

– If Windows Me or 98 SE is being used, continue with step 7.

3 Click “File” in the menu bar, and then click “Server Properties”.

4 Click the Drivers tab.

5 From the “Installed printer drivers” list, select the printer driver to be 
deleted, and then click the [Remove] button.

6 When a message appears, requesting confirmation to delete the printer 
driver, click the [Yes] button.

7 Close the open windows.

8 Restart the computer.
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Deleting related files

Even after the printer driver is deleted from the Printers and Faxes window, 
device information files remain on the computer.

When using Windows XP/Server 2003, it may not be possible to overwrite 
the driver, even if the same version of the printer driver is reinstalled. If the 
printer driver cannot be upgraded, even by reinstalling it, follow the proce-
dure described below to also delete the device information files.

1 Open the following folder.

– C:\WINDOWS\system32\spool\drivers\w32x86
– Depending on the computer settings, the Windows folder may not 

be displayed. Follow the on-screen instructions to specify the set-
tings that are displayed.

2 If there are folders with names containing this machine’s name, delete 
those folders.

– However, if both the GDI printer driver and PCL printer driver are in-
stalled, delete device information for both. If only one driver re-
mains, do not delete it.

3 Open the following folder.

– C:\WINDOWS\inf
– Depending on the computer settings, the inf folder may not be dis-

played. Click “Folder Options” in the “Tools” menu, click the View 
tab, and then select “Show hidden files and folders”.

4 Delete “oem*.inf” and “oem*.PNF”, which contain information on this 
machine.

– “*” indicates a number in the file names for “oem*.inf” and 
“oem*.PNF”. The number differs depending on the computer envi-
ronment. Before deleting the files, open the INF file, and check the 
model name indicated in the last few lines to verify that the file is for 
the corresponding model. The PNF file has the same number as the 
INF file.

5 Restart the computer.
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3 Specifying printer driver settings

Descriptions on the printer driver settings available when printing from a 
computer are provided below.

3.1 Printer driver settings dialog box

Displaying the settings dialog box

Select the printer in the Printers and Faxes window (the Printers window in 
Windows 2000/Me/98 SE), and then display the printer driver settings dialog 
box. The settings specified in this dialog box are applied to all applications.

1 Open the Printers and Faxes window (or the Printers window).

– For Windows XP/Server 2003, click the [Start] button, and then 
click “Printers and Faxes”.

– For Windows 2000/Me/98 SE, click the [Start] button, point to “Set-
tings”, and then click “Printers”.

2 In the Printers and Faxes window (or the Printers window), select the 
printer icon for this machine.

3 On the “File” menu, select the command for displaying the printer driv-
er settings dialog box.

– With Windows XP/Server 2003/2000, click “Printing Preferences” 
on the “File” menu.

– With Windows Me/98 SE, click “Properties” on the “File” menu.
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The following printer driver settings dialog box appears.

2
Note 

To change the settings for each job to be printed, click the [Properties] 
button (or the [Preferences] button) in the Print dialog box, which appears 
when “Print” is clicked in the application. The settings specified in the di-
alog box displayed from the Print dialog box are only applied temporarily, 
and the settings return to those in the printer driver settings dialog box 
when the application is exited.

A program containing specified driver settings can be registered and re-
called when needed by using the Easy Set function. For details on the 
Easy Set function, refer to “Easy Set” on page 3-9.

To display the Device Options tab in Windows XP/Server 2003/2000, 
click “Properties” on the “File” menu of the Printers and Faxes window 
(or the Printers window).
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Printing Preferences dialog box

Printing settings can be specified from the printer driver settings dialog box.

2
Note 

To display the Printing Preferences dialog box in Windows XP/Server 
2003/2000, click “Printing Preferences” on the “File” menu of the Printers 
and Faxes window (or the Printers window).

To display the Printing Preferences dialog box in Windows Me/98 SE, 
click “Properties” on the “File” menu of the Printers window.
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Tab Item Description

Setup Orientation Select the paper orientation of the document.

Original Size Specify the paper size for the document.

[Edit Custom] button Specify a user-defined paper size.

Output Size Specify the size of paper to be printed on. If this 
size is different from the original document size, 
the image will automatically be enlarged or re-
duced.

Zoom Specify the enlargement or reduction ratio.

Copy Specify the number of copies to be printed.

Collate Select whether multiple copies of a multi-page 
document is to be printed by set or by page.

Paper Source Select the paper drawer that is to be used.

Paper Type Select the type of paper that is to be used.

Output Method Select the output method.

Layout Combination Multiple document pages can be printed together 
on a single sheet of paper.

[Combination Details] 
button

Settings such as the number of pages printed on 
a single sheet of paper and the printing order can 
be specified as combination details.

Double Sides Select whether pages are printed double-sided.

Binding Position Select the binding position.

Per Page Set-
ting

Front Cover Page Select whether a document page is printed on the 
front cover.

Front Cover Paper 
Source

Select the paper drawer loaded with paper for the 
front cover.

Media Type Select the type of paper used for the front cover.

Watermark Watermark Select Select whether the document is printed overlap-
ping a watermark (text stamp).

1st Page Only Select if the watermark is printed only on the first 
page.

[New] button Create new watermarks.

[Edit] button Change the watermarks.

[Delete] button Delete a watermark.

Quality Resolution Specify the print resolution.

[Adjustment] button Specify the brightness and contrast.

About - Shows the software version information.
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Properties dialog box

Installed options can be selected from the Properties dialog box for the print-
er driver.

2
Reminder 

If the options installed on the machine are not specified from the Device 
Options tab, the functions available with the option cannot be used from 
the printer driver. Be sure to specify the corresponding settings when op-
tions are installed.

2
Note 

To display the Device Options tab, click “Properties” on the “File” menu 
of the Printers and Faxes window (or the Printers window).

Tab Item Description

Device Options Device Options Specify the settings for the installed paper draw-
ers.

Memory Specify the size of the installed memory.
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3.2 Device Options tab

Specify whether or not options are installed so that the options installed on 
the machine can be used from the printer driver.

2
Reminder 

If the options installed on the machine are not specified from the Device 
Options tab, the functions available with the option cannot be used from 
the printer driver. Be sure to specify the corresponding settings when op-
tions are installed.

2
Note 

To display the Device Options tab, click “Properties” on the “File” menu 
of the Printers and Faxes window (or the Printers window).
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Device Options

Specify the settings for the installed paper drawers.

From the “Device Options” list, double-click the names of installed paper 
drawers to specify that it is installed. Double-click the name again to return 
the setting to “Not Installed”.

Memory

Specify the size of the installed memory.

Click [,] on the right side of the “Memory” box, and then select the size of 
the installed memory.
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3.3 Common operations

This section contains descriptions of buttons and functions common to all 
tabs of the dialog box. The actual buttons may appear differently depending 
on the operating system.

Common items

Button Description

[OK] button Click this button to apply the specified settings and close the dialog 
box.

[Cancel] button Click this button to cancel the specified settings (not apply them) 
and close the dialog box.

[Apply] button Click this button to apply the specified settings without closing the 
dialog box.
This button is not displayed on the setting screen that appears when 
the [Properties] button (or the [Preferences] button) is clicked in the 
Print dialog box of the application.

[Help] button When this button is clicked, help information for the currently dis-
played settings appears.

Preview Shows a preview of the specified paper settings or shows the printer 
status.
Click the button in the lower-left corner of the preview to change it 
between [Paper View] and [Printer View] and to select the preview 
display.
When the [Paper View] preview is selected, a sample page layout for 
the currently selected settings is displayed so that an image of the 
print result can be checked.
When the [Printer View] preview is selected, an image of the printer 
configuration, including the options, such as the paper drawers, cur-
rently installed on the machine, is displayed. The paper drawers se-
lected in the “Paper Source” list on the Setup tab appear in light 
blue.

Printer ViewPaper View
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Easy Set

The currently specified settings can be registered as a program to be re-
called later when you wish to use those settings again.

1 Change the driver settings on the Setup and Layout tabs.

2 In the “Easy Set” box, type the name of the program.

3 Click the [Save] button.

The settings program is registered.

Easy Set The currently specified settings can be registered as a program to be 
recalled later.

Button Description
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2
Note 

To recall a registered program, select it from the list.

To change the name of the registered program, select the program from 
the list, and then type in the new program name. The button changes to 
the [Rename] button. To change the program name, click the [Rename] 
button.

To delete a registered program, select the program from the list. The but-
ton changes to the [Delete] button. To delete the program name, click the 
[Delete] button.

If “Factory Default” is selected from the list, all settings return to their de-
faults.

A maximum of 20 characters can be entered for the registered name.

A maximum of 31 programs can be registered.
3-10 GDI Printer Controller



Specifying printer driver settings 3
3.4 Setup tab

From the Setup tab, settings can be specified for the document and paper 
to be printed on. The number of copies to be printed and the orientation of 
the printed image can also be specified.

Orientation

Select whether to print the document in the portrait or landscape orientation.

ABCD ABCDEF

Portrait Landscape
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Original Size

From the drop-down list, click the paper size for the document to select it.

The following standard paper sizes are available.

2
Note 

If “Hagaki” is selected, select the “Hagaki” paper setting for Tray 1 from 
the control panel of the machine.

“Hagaki” and the envelope and non-standard sizes can be selected when 
“Paper Source” is set to “Auto”, “Tray 1” or “Bypass”.

When “Paper Type” is set to “OHP”, only “Letter” and “A4” are available.

Setting Actual size Setting Actual size

Letter 8 1/2 × 11 in. FLS 220 × 330 mm

Legal 8 1/2 × 14 in. FLS 8 1/8 × 13 1/4 206 × 337 mm

11 × 17 11 × 17 in. FLS 8 × 13 203 × 330 mm

A3 297 × 420 mm 11 × 14 11 × 14 in.

A4 210 × 297 mm Invoice 5 1/2 × 8 1/2 in.

A5 148 × 210 mm Env.You-1 120 × 176 mm

B4 257 × 364 mm Env.You-4 105 × 235 mm

B5 182 × 257 mm Env.You-6 98 × 190 mm

Env.Com10 4 1/8 × 9 1/2 in. 8K 270 × 390 mm

Env.DL 110 × 220 mm 16K 195 × 270 mm

Env.C6Envelope 114 × 162 mm Hagaki 100 x148 mm

FLS 8 1/4 × 13 210 × 330 mm Env.C6 3/4 3 5/8 × 6 1/2 in.

FLS 8 1/2 × 13 216 × 330 mm
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Edit Custom

A paper size that does not appear in the list can be registered as a custom 
size.

1 Click the [Edit Custom] button on the Setup tab.

The Custom Size Settings dialog box appears.

2 Click the [New] button.

The Custom Size Settings dialog box enlarges to display settings for 
specifying the paper size.

3 In the “Name” box, type the name of the paper size.
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4 In the “Dimensions” group box, specify the width and length of the pa-
per.

– To change the units for specifying the paper size, select the desired 
setting in the “Unit” group box.

5 Click the [OK] button in the lower-right corner of the Custom Size Set-
tings dialog box.

The paper size settings in the Custom Size Settings dialog box are hid-
den.

6 Click the [OK] button in the Custom Size Settings dialog box.

The non-standard size is registered and can be selected from the list 
of paper sizes.

2
Note 

To change the width and length of a registered non-standard size, select 
the paper size in the Custom Size Settings dialog box, click the [Edit] but-
ton, and then change the settings. The name cannot be changed.

To delete a registered non-standard size, select the paper size in the 
Custom Size Settings dialog box, and then click the [Delete] button.

A maximum of 20 characters can be entered for the registered name.

A maximum of 32 sizes can be registered.
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Output Size

Select the size of paper that is to be used for printing.

The available standard paper sizes are same as those available in the “Orig-
inal Size” list.

If the paper size is different from the size selected in the Original Size list, the 
document image will be printed enlarged or reduced so that it fits in the se-
lected paper size.

The enlargement/reduction ratio to be used for printing can be checked in 
the Paper preview.

2
Note 

If “Manual” is selected in the “Zoom” group box, a setting cannot be se-
lected from the “Output Size” list.

If any setting other than “Off” is selected in the “Combination” list on the 
Layout tab, a setting cannot be selected from the “Output Size” list.
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Zoom

Specify the enlargement or reduction ratio to be used for printing.

Select “Manual”, and then type in a number between 25% and 400%, or 
click the arrows to specify a setting.

2
Note 

If any setting other than “Same as Original Size” is selected in the “Output 
Size” list, “Manual” cannot be selected.

Copy

Specify the number of copies to be printed.

Type in a number between 1 and 99, or click the arrows to specify a setting.

Original

Reduced Enlarged
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Collate

When printing multiple copies of the same document, select whether the en-
tire document is printed one copy at a time or whether the specified number 
of copies are printed one page at a time.

When the “Collate” check box is selected, the entire document is printed one 
copy at a time. For example, if “Copy” is set to “5”, the entire document (from 
the first page to the last page) is printed five times.

When the “Collate” check box is cleared, the specified number of copies are 
printed one page at a time. For example, if “Copy” is set to “5”, the first page 
of the document is printed five times, and then the second page is printed 
five times. Printing continues until the last page is printed five times.

2
Note 

Depending on the application being used, the Collate setting may not be 
applied. If Collate is specified from the printer driver, Collate cannot be 
used in the application.

If “1” is specified in the “Copy” box, Collate is not available.

Check box selected Check box cleared
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Paper Source

Select the paper drawer loaded with the paper.

If “Auto” is selected, the paper drawer loaded with paper of the size specified 
in the “Output Size” list is used.

The available settings differ depending on the options that are installed.

Settings: Tray 1, Tray 2 through Tray 5 (options), Bypass

2
Note 

If “Hagaki” or an envelope or non-standard size is selected in the “Origi-
nal Size” list, only “Tray 1” and “Bypass” are available.

Only “Tray 1” and “Bypass” are available when “Paper Type” is set to 
“OHP”, “Thick Paper” or “Envelope”.

Paper Type

Select the type of paper to be printed on.

Settings: Plain Paper, OHP, Thick Paper, Envelope

2
Note 

A setting can be selected only when “Paper Source” is set to “Tray 1” or 
“Bypass”.

“OHP” can be selected only when “Original Size” is set to “Letter” or 
“A4”.

Bypass tray
Tray
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Output Method

Select the printing method.

Not only can data be printed directly, but “Secure Print” is also available, 
which requires a password for printing from this machine.

Settings: Print, Secure Print

2
Note 

“Secure Print” is available only if the optional expanded memory unit is 
installed.

Using secure printing

A password can be specified for a document. The document printed from a 
computer is temporarily saved in the machine’s memory and is printed when 
the password is entered with the machine’s control panel. Select this setting 
when printing highly confidential documents.
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Specifying secure printing from the printer driver

1 Click the Setup tab.

2 From the “Output Method” drop-down list, select “Secure Print”.

A screen appears, allowing you to type in the password.

3 Type in the password, and then click the [OK] button.

– Specify the 4-digit password between 0000 and 9999.

4 The print job is sent.

– Normal printing is performed when printing is specified from an ap-
plication.

Printing from the machine

The password must be entered from the control panel of the machine in or-
der to print a document with a password specified when “Secure Print” is se-
lected in the printer driver.

1 Check that the “Printer” 
indicator is flashing or is 
lit, and then press the 
[Printer] key.

The Print mode screen 
appears.
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2 Check that the key icon appears in the upper-right corner of the screen.

– The key icon appears if the memory contains a secure print docu-
ment.

3 Press the [Access] key.

4 When “PASSWORD: – – – –” appears, type in the password.

– Type in the same numbers specified as the password from the 
printer driver.
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5 Check that the document can be printed.

If the password is correct, the following screen appears, and the job is 
printed.

2
Note 

If there are multiple secure print jobs with the same password, all of those 
secure print jobs are printed.
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3.5 Layout tab

From the Layout tab, select the number of document pages to be printed on 
a single sheet of paper.
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Combination

Multiple document pages can be printed together on a single sheet of paper. 
Use combined printing to economize on the number of printed pages.

From the drop-down list, select the number of pages to be printed on a single 
sheet of paper.

For example, if “2 in 1” is selected, two pages will be printed on a single sheet 
of paper. If “Off” is selected, one page is printed on a single sheet of paper.

Settings: Off, 2 in 1, 4 in 1, 6 in 1, 9 in 1, 16 in 1

1 2 1 2

3 4

1 2

4 5

3

6

1 2

4 5

3

6

7 8 9

1 2

5 6

3

7

9 10 11

4

8

12

13 14 15 16

4 in 1

2 in 1

6 in 1

9 in 1 16 in 1
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Combination Details

Click the [Combination Details] button to specify the printing order and 
whether or not to print page outlines.

Combination Select the number of pages to be printed on a single sheet of paper.
This is the same setting selected in the “Combination” list on the 
Layout tab.

Order When multiple pages are printed on a single sheet of paper, select 
the direction and order for printing the pages.
Settings:

Border Line Select this check box to print an outline around each page when 
multiple pages are printed on a single sheet of paper.

Upper Left-
Rows

Upper Right-
Rows

Upper Left-
Columns

Upper Right-
Columns
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Double-sided printing

Document pages can be printed on both sides of the paper. Print on both 
sides when binding a multi-page document.

1 Click the Layout tab.

2 From the “Double Sides” drop-down list, select “Double Sided”.

2
Note 

From the “Binding Position” drop-down list, select the desired binding 
position.

2
Note 

Double sided printing is available only when the optional automatic du-
plex unit is installed.
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3.6 Per Page Setting tab

From the Per Page Setting tab, specify whether or not a cover page is added.

Front Cover Page

Select whether or not a cover page is added and whether or not a document 
page is printed on the cover page.

Settings:

Front Cover Paper Source

Select the paper drawer loaded with the paper for the cover pages.

Settings: Tray 1, Tray 2 through Tray 5 (options), Bypass

Media Type

Select the type of paper to be used for the cover page.

Settings: Plain Paper, OHP, Thick Paper, Envelope

None No cover page is added, and the entire document is printed on paper 
from the same paper drawer.

Blank A blank sheet of paper from the paper drawer specified in the “Front 
Cover Paper Source” list is added as a cover page.

Printed The first page of the document is printed on paper from the paper 
drawer specified in the “Front Cover Paper Source” list and is added 
as a cover page.
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3.7 Watermark tab

From the Watermark tab, specific text can be printed in the background as a 
watermark.

Watermark Select

From the Watermark Select list, select the text. A setting is available for 
specifying whether the watermark is printed on all pages or only on the first 
page.

Settings: No Watermark, CONFIDENTIAL, COPY, DO NOT COPY, DRAFT, 
FINAL, PROOF, TOP SECRET

1 Click the Watermark tab.

2 From the list, select the watermark to be printed.

3 To print the watermark only on the first page, select the “1st Page Only” 
check box.

– To print the watermark on all pages, clear the check box.
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Creating a new watermark

A new watermark can be registered.

1 Click the Watermark tab.

2 Click the [New] button.

The New dialog box appears.

3 In the “Watermark Text” box, type in the text to be used as the water-
mark.

– A maximum of 20 characters can be entered for the text.
– A maximum of 32 watermarks can be registered (including “No Wa-

termark”).

4 Specify the desired settings.

– Font: Select the font for the watermark. Any font installed on the 
computer can be selected.

– Bold: Select to use bold text.
– Italic: Select to use italic text.
– Size: Specify a character size between 7 and 300 points.
– Angle: Specify the angle that the text is printed on the paper. A set-

ting between 0° and 359° can be specified.
– Darkness: Specify the density of the text. A setting between 10% 

and 100% can be specified.
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– Offset from Center: Specify the horizontal and vertical positions for 
the location where the text is to be printed. Settings between -100 
and 100 can be specified.

– The position can also be changed by using the sliders below and to 
the right of the preview image.

5 Click the [Add] button.

The watermark is added to the “Watermark Select” list.

Horizontal direction:
Reducing the number 
moves the text to the 
left.

Vertical direction:
Increasing the number 
moves the text up.
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Editing a watermark

A registered watermark can be edited to change the text, size and position.

1 Click the Watermark tab.

2 From the list, select the watermark to be edited.

3 Click the [Edit] button.

The Edit dialog box appears.

4 Specify the desired settings.

– Watermark Text: Type in the watermark text.
– Font: Select the font for the watermark. Any font installed on the 

computer can be selected.
– Bold: Select to use bold text.
– Italic: Select to use italic text.
– Size: Specify a character size between 7 and 300 points.
– Angle: Specify the angle that the text is printed on the paper. A set-

ting between 0° and 359° can be specified.
– Darkness: Specify the density of the text. A setting between 10% 

and 100% can be specified.
– Offset from Center: Specify the horizontal and vertical positions for 

the location where the text is to be printed. Settings between -100 
and 100 can be specified.

– A maximum of 20 characters can be entered for the text.
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– The position can also be changed by using the sliders below and to 
the right of the preview image.

5 Click the [OK] button.

The watermark is changed.

2
Note 

To delete a registered watermark, select the watermark from the list, and 
then click the [Delete] button.

Horizontal direction:
Reducing the number 
moves the text to the 
left.

Vertical direction:
Increasing the number 
moves the text up.
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3.8 Quality tab

From the Quality tab, settings for the print quality can be specified.

Resolution

From the drop-down list, select “600 × 600 dpi” or “300 × 300 dpi” as the 
print resolution.

2
Note 

When “600 × 600 dpi” is selected, the print quality is increased, but the 
printing time is longer than if “300 × 300 dpi” is selected.
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Adjustment

Click the [Adjustment] button to specify the brightness and contrast.

Brightness Adjust the brightness of the printed image. A setting between -50 
and 50 can be specified.
The larger the number, the higher the contrast and the more distinct 
the image.

Contrast Adjust the contrast of the printed image. A setting between -50 and 
50 can be specified.
The larger the number, the brighter the image.
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4 Control panel operations

Descriptions on the printing operations that can be performed from the con-
trol panel of the machine are provided below.

4.1 Printing operations

The default mode of the machine is the Copy mode. Normally, when printing 
is performed from a connected computer, printing begins automatically.

For details, refer to “Starting the print operation” on page 4-3.

To print with “Bypass” selected in the “Paper Source” list on the Setup tab, 
refer to “Using the manual bypass tray” on page 4-7.

Control panel

1 3 4 52

8 7 6

No. Item Description

1 Display • While print data is being received, “>>PRINTER:Printing” 
appears in the display.

• In addition, if the [Printer] key is pressed while the machine 
is receiving print data (the Printer indicator is lit), the paper 
source and paper size settings and the user name for the 
current print job appear.

2 OK key • Press this key to select the function shown in the display.

3 Arrow (up, down, left and 
right) keys

• Press these keys to change the menu shown in the display.
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2
Note 

The [Fax] key and the fax function keys can be used only if the optional 
fax kit is installed on the machine.

The [Scan] key can be used only if the optional fax kit and optional net-
work interface card NC-503 or image controller IC-206 are installed on 
the machine.

4 Printer indicator • This indicator flashes when the machine is receiving print 
data.

• This indicator lights up when the machine is printing the 
print data. (The indicator lights up if data is being received 
at the same time.)

• This indicator goes off if there is no print data.
• Refer to “Printer indicator” on page 4-3.

5 Printer key • Press this key when the machine is receiving print data 
(Printer indicator is lit) to display the Printer mode screen.

• To return to the mode before entering Printer mode, press 
this key while the Printer mode screen is displayed.

• If there is no print data in the machine’s memory, the Printer 
mode screen does not appear, even if the [Printer] key is 
pressed.

6 Clear/Stop key • To cancel the current print job while print data is being re-
ceived, press the [Printer] key, and then press this key 
when the Printer mode screen appears. Refer to “Canceling 
a print job” on page 4-4.

7 Start indicator • This indicator lights up in orange when the machine is re-
ceiving print data.

8 Caution indicator • This indicator lights up when an error or malfunction has 
occurred.

No. Item Description
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Printer indicator

The “Printer” indicator shows the status of the printer data sent from the 
computer.

Starting the print operation

Normally, printing begins when printing is performed from a connected com-
puter.
- Normally, when printing is performed from a connected computer, print-

ing begins automatically.
- If a print operation is performed from a connected computer while the 

machine is copying, printing begins automatically when no copy opera-
tion is performed for 30 seconds.

- When using the optional fax kit: If print data is received while fax data is 
being received, the printing of print data has priority.
After the reception job is completed in Fax mode, the print data is printed, 
and then the fax is printed.

- While printing, copy settings can be specified and fax operations can be 
performed. (Copies and faxes are printed after printouts are printed.)

Printer indicator Printing status

Flashing • The machine is receiving print data. The indicator also flashes in 
other modes.

• An error has occurred in the machine.

Lit • Print data is being printed. Instead of flashing, the indicator re-
mains lit when data is being received during printing. 

Off • There is no print data in the machine’s memory.
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Canceling a print job

Printing of a print job can be canceled from the control panel of the ma-
chine’s control panel. However, a print job can only be canceled from the 
control panel while the machine is in Printer mode.

1 Check that the Printer indicator is flashing or is lit, and then press the 
[Printer] key.

2 Check that “PRINTER MODE PRINTING” appears in the machine’s dis-
play.

– The message that appears differs depending on the status of the 
machine.

3 Press the [Clear/Stop] 
key.

The confirmation message “JOB CANCEL” appears.
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4 Press the [+]or [,] key to 
select “YES”, and then 
press the [OK] key.

– To continue printing, 
select “No”.

– If no key is pressed 
within five seconds, 
printing continues.

“ACCEPTED” appears in the display and the print job is canceled.
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2
Note 

If any of the following messages appear in the display, the print job can 
also be canceled by repeating steps 2 and 3 from the procedure de-
scribed above.

PAPER EMPTY

PAPER JAM

PAPER SIZE ERROR

RESET PAPER

NO SUITABLE PAPER

UPPER TRAY FULL

REMOVE PAPER IN BYPASS TRAY

LOAD PAPER

INCORRECT PAPER SIZE

MEDIA TYPE ERROR

*RECEIVING*

FRONT COVER OPEN

1st SIDE COVER OPEN

DUPLEX COVER OPEN

TONER EMPTY
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Using the manual bypass tray

Follow the procedure described below when using the manual bypass tray 
to print one page at a time.

1 From the computer, display the Setup tab for the printer driver, and 
then select “Bypass” in the “Paper Source” list (page 3-18).

2 Perform the print operation from the computer.

3 When the message “PRINTER MODE LOAD PAPER” appears, load pa-
per into the manual bypass tray.

– Insert one sheet of 
paper with the front 
side facing down, 
lightly sliding the pa-
per as much as pos-
sible into the feed 
slot. 
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– Slide the paper 
guides to fit the size 
of paper being load-
ed.

4 Repeat step 3 as often as necessary until printing of the document is 
finished.

2
Note 

Be sure to load the paper into the manual bypass tray after the print op-
eration is performed from the computer. Follow the procedure described 
below if the paper is loaded into the manual bypass tray before the print 
operation is performed from the computer.

Remove the paper from the manual bypass tray.
Press the [Reset] key.
Press the [Printer] key.
Perform step 3 of the procedure.

Load the paper into the manual bypass tray one sheet at a time.

If the multi bypass tray (optional) is installed, printing from it can be per-
formed in the same way as with any other paper drawer since the multi 
bypass tray can be loaded with 100 sheets of paper.

The multi bypass tray can be loaded with 10 envelopes, 20 OHP trans-
parencies, 20 postcards, 20 label sheets or 100 sheets of plain paper.

Power Save mode

If print data is received while the machine is in Power Save mode, the mode 
is canceled.

When print data is received, the data is printed after the machine has finished 
warming up.
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5 Troubleshooting

Descriptions of the errors that may occur while printing from a computer and 
the procedures for correcting the error are provided below.

If a problem occurs during computer printing, check the following.

5.1 Checking error messages

If a computer printing error occurs while any screen other than the Printer 
mode screen is displayed, the Caution indicator lights up and the message 
“Check Printer Mode” appears in the machine’s display. In this case, perform 
the following procedure.
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1 Press the [Printer] key.

The Print mode screen appears.

2 Check the error message that currently appears in the display, and 
then perform the desired operation to correct the error.
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5.2 Main error messages

The main error messages that appear in the Printer mode screen are de-
scribed below.

Error message Cause Remedy

PAPER SIZE ERROR The size of paper specified 
with the printer driver is differ-
ent from the size of paper 
loaded in the paper drawer.

Pull open the paper drawer 
with the size error, and then 
close it again. Check if a cus-
tom paper size has been en-
tered, and correct the paper 
size from Utility mode.

NO SUITABLE PAPER “Auto” is selected in the “Pa-
per Source” list in the printer 
driver, but paper of the speci-
fied size is not loaded.

Load paper of the specified 
size into a paper drawer.

INCORRECT PAPER SIZE Paper of the size specified in 
the printer driver is not loaded 
in the specified paper drawer.

Change the paper size from 
Utility mode, and then load pa-
per of the appropriate size into 
a paper drawer.
If the multi bypass tray (op-
tional) is used for printing, 
printing begins when the ap-
propriate paper is loaded.

PAPER EMPTY Either no paper is loaded in 
the specified paper drawer or 
the specified paper drawer is 
not installed on the machine.

Load paper of the specified 
size into the specified paper 
drawer.

MEDIA TYPE ERROR Paper of the type specified in 
the printer driver is not loaded 
in the specified paper drawer.

Load the appropriate paper 
into a paper drawer, and then 
change the paper type from 
Utility mode.
If the multi bypass tray (op-
tional) is used for printing, 
printing begins when the ap-
propriate paper is loaded.

MEMORY NEAR FULL The image data received from 
the computer has exceeded 
the capacity of the memory.

Press any key.
Turn the machine off, then on 
again.

SECURE PRINT IS NOT 
AVAILABLE

Since the expanded memory 
unit is not installed, the “Se-
cure Print” setting cannot be 
selected.

The job is cancelled.

NOT ACCEPTED PASS-
WORD

Since the secure print pass-
word is incorrect, the docu-
ment cannot be printed.

Type in the correct password.
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5.3 Print data when an error occurs

The operation performed with the print data when an error occurs differs de-
pending on the type of error that occurred.

With a “MACHINE TROUBLE” error

This error indicates that a severe operating malfunction occurred. When this 
error message appears in the display, the machine cannot receive any print 
data. Contact your technical representative.

Temporary errors

When the following easily corrected errors occur, the print data currently in 
the memory is saved. Printing automatically restarts as soon as the error is 
corrected.
- PAPER JAM
- INCORRECT PAPER SIZE
- PAPER SIZE ERROR
- FRONT COVER OPEN
- 1st SIDE COVER OPEN
- DUPLEX COVER OPEN
- NO SUITABLE PAPER
- PAPER EMPTY
- MEDIA TYPE ERROR

2
Note 

If any of the errors listed above appears, the print job in the memory can 
be canceled. For details, refer to “Canceling a print job” on page 4-4.
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* The print speed is measured under the following printing conditions.
Paper is fed from Tray 1.

bizhub 163/211 is not sold in the USA market.

Print speed* bizhub 163
16 ppm (when printing on A4/Letter v paper at 300 × 300 dpi)
12 ppm (when printing on A4/Letter v paper at 600 × 600 dpi)
bizhub 181
18 ppm (when printing on A4/Letter v paper at 300 × 300 dpi)
12 ppm (when printing on A4/Letter v paper at 600 × 600 dpi)
bizhub 211
21 ppm (when printing on A4 v paper at 300 × 300 dpi)
20 ppm (when printing on Letter v paper at 300 × 300 dpi)
12 ppm (when printing on A4/Letter v paper at 600 × 600 dpi)

Memory Shared with machine

Interface port Compliant with USB Revision 2.0

Printer language GDI

Font Windows

Supported operating systems Windows Server 2003, Windows XP (Service Pack 2 or later), 
Windows 2000 (Service Pack 4 or later), Windows Me, Win-
dows 98 SE or Windows Terminal Server (Windows 2000 
Server/Windows Server 2003)
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